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Classroom Policies: The following guides are for your welfare as well as that of other students. Maintaining the best possible 

educational atmosphere is paramount to the success of all students.

01.	 Check blog one to two days after lecture  http://142dw.wordpress.com/ for homework info, homework videos, in case of 		

	 changes in homework, due dates, additional info.	

02.	 Attendance will be taken at the first 5 minutes of class meeting.

03.	 This is graded class and can be a credit/ no credit class.

04.	 Please inform the instructor if you know you will be late or absent. (limited absences will be excused if the instructor 		

	 is notified prior to a class session) by email: mjaylocation@yahoo.com. Please do not send assignments via email unless 	

	 requested.

05.	 Arrangements can be made in special circumstances (i.e. childcare problems, work conflicts, dependent illness, etc.) for 	

	 alternative participation within limits.

06.	 A break will be after 25 minutes during the lecture. Students are encouraged to use the tables in the “break area" since no 	

	 liquids nor food(s) are allowed by the computers.

07.	 Students should plan their workday to remain at task during the whole class session.  Some workstations are limited and 	

	 may not be available.

08.	 The copying or "down-loading” of software from the hard drive (except individual student files and exercise files) to external 	

	 media is considered stealing and is illegal. Students in violation of this policy will be removed immediately from class with a 	

	 failing semester grade. Students will be subject to prosecution by the college district.

09.	 Smoking is permitted outside only. Please use the appropriate receptacles for cigarettes when you are through.

10.	 Cellular phones can be active, but leave the room when answering to converse.

11.	 This course using Adobe Photoshop CS5 and Dreamweaver CS5 and all tests and information will be related to this version.

12.	 Quizzes are given in the first fifteen minutes of the first hour of class and are timed.

13.	 Withdrawal from the class is the responsibility of the student, not the instructor's.

14.	 Students need to be present for the presentations to receive a grade for them.

15. Students need to be have full paid registration and have all dues paid, such as overdue dues from the library.

16.	 It is necessary to have the required textbook by the end of the first week of class to enable you to take the tests and 		

	 complete assignments without penalty.

17.	 Back up your work to USB flash drive or external hard drive. Computer failure or file corruption is not accepted as an 		

	 excuse.

18.	 Procedure in Turning in Exercises & Assignments. 
	 Most of the exercises not be required email. Those that due need to sent in this format.
	 In the subject area of the email: last name, first intital (if you have a common last name, include first name instead), class 	
	 number (142), and exercise name.

mailto:mjaylocation@yahoo.com
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COURSE OUTLINE

Course Description: A basic course in the designing using Adobe Dreamweaver CS5 for the Macintosh and Windows. 
The usage of Photoshop will be used in the course as well. Topics covered include: Introduction to the thought process in 
organizing, and creating a simple web site with hypertext links to secondary pages,  email addresses, and graphic link.  In 
addition, lectures will cover what formats are required for photographs and graphics and optimization, site management and 
creating files compatible for  all web browsers. Other areas covered are functions of Dreamweaver’s toolbar, tables, frames, 
css rollovers, and creation of web pages with html with an external css file.
Instructional goal: 
1. Organize and produce a web site from conception to completion.
2. Demonstrate proficiency in Adobe Dreamweaver basic web construction.
3. Demonstrate an understanding of web design aesthetics and the conventions underlying current industry practice, as 		
	 evidenced by their final project.

Specific Student Performance Objectives: Upon successful completion of course a student will be able to: use most of 
Dreamweaver’s tools with a strong technical and aesthetic base to design Internet web pages and sites.

Instr. Methods/Strategies: Informational demonstrations; manipulative demonstrations; cooperative learning groups; 
questions/answers method; independent study; discussions; guided practice; group/individual critiques; Dreamweaver 
assignments.

Equipment / Facilities: You must, of course, provide your own original photographs, digital files of 600 ppi minimum, or 
images from a free stock image website. The department provides a full complement of Macintoshes that doubles as a 
Windows based computers equipped with at least 250 Gig hard drives and minimum a minimum of 2 gig of memory. There 
are one flatbed 600 DPI scanning stations.

Supplies:  You are required to purchase 1 Gb USB flash drive (minimum size) for the exercises.

Blog:  http://142dw.wordpress.com/

Textbook: None, but if you have need for a book, I recommend “Creating a Web Site in Dreamweaver CS4: Visual 
QuickProject Guide” [Paperback] 032159150X
Pre-requisites/Co-requisites:  136 Adobe Photoshop Basics required.

Attendance: Class attendance is required. Attendance means arriving on time and staying for the entire class session. This 
course requires that you be present at, and participate in, every class session. Failure to attend classes, tardy arrivals, and 
early departures, will be reflected in final grades as follows:

• Four (4) Late’s will drop the final grade by one full grade (B to C; C to D, etc...);
• Arriving 30 minutes or more after the start of class or leaving 30 minutes or more before the end of class will be considered 
an absence;
• Three (3) unexcused absences will drop the final grade by one full grade (B to C; C to D...);
• Three (3) consecutive unexcused absences or four (4) total unexcused absences will result in a final grade of F.

Critiques, Examinations & Lab Section:  Successful completion of Dreamweaver assignments.   Grading  is determined by 
technical competency: are you understanding and using the tools and commands of the program fluently for aesthetics: how 
well 	are you using your creativity and imagination in fulfilling the requirements of the assignment.  Examinations given, in a 
written format, and a midterm with a possible addition of a final.

Lecture-Lab Attendance	 25%	 Quizzes		  20%		
Open Lab Attendance	 05%			 
Projects	 50%	
		
Grades: All of the above items will be used in determining your final grade
	 100-91% = A
	 90-81% = B
	 80-71% = C
	 70-61% = D
	 60% and lower = F

mailto:mjaylocation@yahoo.com
http://142dw.wordpress.com/
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Exercises, Homework & Projects Due Date

Assignment #1 Resampling image (page 6 of syllabus) 02/02/12

Homework #1 HTML tags (homework instructions will be 
sent weekly via email. weekly

Assignment #2 Simple Website in Dreamweaver, No 
tables  Refer to page 9 of syllabus 02/09/12

Homework #2 Creating a table based website using corebrand graphics part 1 02/16/12

Homework #3 Creating a table based website using corebrand graphics part 2 02/23/12

Homework #4 Creating a table based website using corebrand graphics part 3 03/01/12

Homework #5 Creating a css positioned website using corebrand graphics part 1 03/08/12

Homework #6 Creating a css positioned website using corebrand graphics part 2 03/15/12

Homework #7 Creating a css positioned website using corebrand graphics part 3 03/22/12

Homework #8 Creating a css positioned website using corebrand graphics part 4 03/29/12

Project #1 Simple Website using graphics and CSS for 
text and positioning, 2 pages 04/19/12

Project #2 Website CSS Positioned 10 pages not related 
to Project #1. 		  Send by email, zip file & URL 05/24/12

mailto:mjaylocation@yahoo.com
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(Outline continued on next page)

Date Lectures and Meetings Due Date

01/26/12 Introduction to the course and students expectations.  On-screen file for-
mats.
Demonstration in resampling images with an image from Stock Exchange 
and what resolution it should be needed for the Web and what resolution  if 
the image needs to be retouched first. 
Sign up to use the image bank, Stock Exchange, http://www.sxc.hu. for 
Resampling assignment.

02/02/12 Review how to create a simple html website with no css. Table based web 
design. Using Corebrand graphic  for slicing. Discussion of alignment with 
table based design. Assignment demo: Create a web pages in Photoshop 
CS5 demonstration in order to understand tables and slicing. Basic file 
management with web design. Understanding HTML and tables by using 
Photoshop CS5 and its Save as Web and Devices Dialog box area.
main table. Alignment of cells within all tables. Lecturing on corebrand - 
table based
Discussion on HTML tags. 

Continue in lecturing on corebrand - table based part 1. Lecture on sepa-
rate tables, header, content, and footer, nested within the table.

02/09/12 Continue in lecturing on corebrand- table based part 2

02/16/12 Continue in lecturing on corebrand- table based part 3
Dividing the web page into three divisions, header, content and footer. 

02/23/12 This is the transition lecture from tables to CSS (Cascading Style Sheets).
Lecturing on corebrand- css positioned part 1, ID and Float
Lecture graphic hyperlinks, meta tags: keywords, description and measur-
ing in pixels. 

03/01/12 Lecturing on corebrand- css positioned part 2
Uploading website via FTP to server. Use either your own or http://
www.000webhost.com

03/08/12 Lecturing on corebrand- css positioned part 3
Review on templates and libraries related to web accessibility reports.

03/15/12 Lecturing on corebrand- css positioned part 4, 5, 6 
Review ID, classes and floats. Discussion on comping and site mapping in 
Photoshop or illustrator or Dreamweaver. Review web pages in Photoshop 
demonstration.
Understanding floats and document flow. Use a clear class to correct docu-
ment flow changes due to floats.

03/22/12 Review using CSS with floats. Review dividing the web page into three divi-
sions, header, content and footer. Understanding how to use an ID and a 
class.

03/29/12 Wireframe layout of Project #2 due.

mailto:mjaylocation@yahoo.com
http://www.sxc.hu
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Date Lectures and Meetings Due Date

04/05/12 Spring Break

04/12/12 Design layout of Project #2 due. 

04/19/12 Lecture on Templates

04/26/12 Animated GIF, Quicktime and other media. Lecture on Creating GIF anima-
tions with Photoshop.
Review automating using the Batch function in Photoshop to create thumb-
nails and JPEGs Lecture on Action palette in Photoshop

05/03/12 Review usage of web developer and firebug

05/10/12 Lab.

05/17/12 Last chance to ask or fix css problems for your 10 page css website.

05/24/12 Project #2 due.

mailto:mjaylocation@yahoo.com
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Sample Rubric for Assessing Dreamweaver Visual Composition
1. Concept, idea, visualization:
PTS Assessment
5 Shows coherency of the concept with a high degree of originality and so-

phistication. The idea is well stated with visual elements and cues match-
ing composition’s communication goal especially in the use of photo-
graphic images and use of type as a design element.

4 Shows coherency of the concept with some originality and sophistication. 
The idea is stated with visual elements and cues but needs to be clearer 
or more strongly evident especially in the use of high contrast visual rela-
tionships and use of type as a design element.

3 Shows some coherency of the concept with commonly used, cliché or 
stereotyped imagery. The idea is obtuse, and requires greater clarity 
through the use of visual elements and cues especially in the use of high 
contrast visual relationships and use of type as a design element.

2 Lacks general coherency of the concept. Many of the visual elements and 
cues do not lead the viewer to the intended idea.

1 Lacks any coherency of the concept. visual elements and cues do not 
lead the viewer to the intended idea.

0 The work was not presented to me.
2. Composition & design:
PTS Assessment

5 Shows strong internal integrity of the visual elements. Nothing needs to be 
added or removed – composition framing is superb.

4 Shows internal integrity of the visual elements. A visual element needs to 
be added, moved or removed – composition framing needs some slight 
adjustment.

3 Shows obvious weaknesses in the internal integrity of the visual elements. 
Many visual elements need to be added, moved or removed – composi-
tion framing needs definite adjustments.

2 Image is breaking apart – there is very little internal integrity of the visual 
elements. Most visual elements need to be rethought – composition fram-
ing needs major readjustment.

1 Visual integrity is nonexistent and image has broken apart. All of the visual 
elements need to be rethought – composition framing needs a complete 
overhaul.

0 The work was not presented to me.

mailto:mjaylocation@yahoo.com
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3. Technical:
PTS Assessment
5 Shows mastery in the use of Dreamweaver software techniques to at-

tain the assignment parameters. This includes the ability to insert images, 
format text and correct tag, to insert DIVs for positioning, correct target-
ing of tags with DIVs, usage of Floating elements, and using class:clear 
to correct incorrect document flow, due to Floats. Usage of *, #wrapper, 
#header, #content, and #footer and all DIVs as an external file rather than 
embedded, separating the presentation styles from the html file.

4 Shows a good command of the use of Dreamweaver software techniques 
to attain most of the assignment parameters. This includes some of fol-
lowing:
the ability to insert images, format text and correct tag, to insert DIVs for 
positioning, correct targeting of tags with DIVs, usage of Floating ele-
ments, and using class:clear to correct incorrect document flow, due to 
Floats. Usage of *, #wrapper, #header, #content, and #footer and all DIVs 
as an external file rather than embedded, separating the presentation 
styles from the html file.

3 Shows some command of the use of Dreamweaver software techniques 
to attain some of the assignment parameters. This includes few of follow-
ing:
the ability to insert images, format text and correct tag, to insert DIVs for 
positioning, correct targeting of tags with DIVs, usage of Floating ele-
ments, and using class:clear to correct incorrect document flow, due to 
Floats. Usage of *, #wrapper, #header, #content, and #footer and all DIVs 
as an external file rather than embedded, separating the presentation 
styles from the html file.

2 Shows limited command of the use of Dreamweaver software techniques 
to attain a few of the assignment parameters. This includes almost none 
of following:
the ability to insert images, format text and correct tag, to insert DIVs for 
positioning, correct targeting of tags with DIVs, usage of Floating ele-
ments, and using class:clear to correct incorrect document flow, due to 
Floats. Usage of *, #wrapper, #header, #content, and #footer and all DIVs 
as an external file rather than embedded, separating the presentation 
styles from the html file.

1 Shows little or no command of the use of Dreamweaver software tech-
niques to attain a few or none of the assignment parameters. The ability to 
insert images, format text and correct tag, to insert DIVs for positioning.

0 The work was not presented to me.

mailto:mjaylocation@yahoo.com
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Resources

Description:  An excellent book for beginners in the design aspect and creating web pages.
Available at: 	 Barnes / Noble, & Border Books, Ebay.com, Amazon.com

Common Letter Extensions

TIFF				    .TIFF				    ILLUSTRATOR		  .AI
JPEG				    .JPEG				    ANIMATED GIF		 .GIF
GIF				    .GIF				    MICROSOFT WORD	 .DOC
PHOTOSHOP			   .PSD				    QUICKTIME MOVIE	 .MOV
HTML				    .HTML				    FLASH / SHOCKWAVE  .SWF

Academic Priced Software

Technology Resource Center	 http://www.gotrc.com 

Campus Technology		  http://www.campustech.com
Sprysoft.com			   http://www.sprysoft.com

Foundation for California Community Colleges http://www.collegesoftware.org

	

mailto:mjaylocation@yahoo.com
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To harden the edges, I chose Fil-
ter > Sharpen > Unsharp Mask and 
entered 100 percent for the Amount 
option and 1.5 for the radius. I chose 
this radius value because it matched 
the radius I used to blur the image.  
Remember that the percentage and 
radius number are just examples and 
apply only to the image below.
(For correcting moires, a threshold 
value of 0 is almost always the best 
choice. A threshold value would not 
only prevent the sharpening of moire 
pattern edges but would also ignore 
real edges, which are already faint 
enough as it is.)
   When you  now switch back to the 
RGB view (command-~) to see the 
combined result of your labors. The 
focus of the image will undoubtedly 
be softer. You can cure this to a 
limited extent by applying very 
discreet passes of the Unsharp Mask 
filter, say, with an amount value of 
100 percent and a low radius value. 
Keep in mind that oversharpening 
Dec. bring the patterns back to life or
even uncover new ones.
   Finally, the most important thing to
remember is always to scan halftone
images at the highest resolution avail-
able to your scanner. Example: If  you 
need to have your final scanned image 
at 200dpi, scan it at 400dpi. Then 
resample the scan down to the desired 
resolution using the Image > Image 
Size command. This step alone goes a 
long way toward eliminating moires.

Cleaning Up a Scanned Halftone
Public-domain images printed in old books and magazines can be wonderful 
scanning resources. Of course, it’s up to you to make sure that the image you 
scan is no longer protected by copyright (most, but not all, works over 75 
years old are considered fair game), or that your noncommercial application of 
the image falls under the fair-use umbrella of commentary or criticism.
    But copyright isn’t the only consideration. When you scan a printed image, 
you’re actually scanning very small halftone dots rather than a continuous-tone 
photograph.  In most cases, the pattern of the halftone dots clashes with the 
resolution of the scanner to produce rhythmic and distracting moire patterns. 
Getting rid of these moires is a problem that eventually haunts nearly
every Photoshop user.
    While there is no infallible method for eliminating moire patterns, you 
can smooth out most images and still retain important detail by applying the 
Gaussian Blur, Median, and Unsharp Mask filters to individual
color channels.  As an example, I’ve scanned an image from a previous issue 
of Macworld and blown up a detail of it, so you can better see the moire 
pattern. (Since I created the original image, Macworld won’t sue me, but
you shouldn’t try it.)
Like most color scans, this is an RGB image. By changing the color model to 
Lab (Mode>LAB) Photoshop allows you to examine the L (Lightness), the 
A(Green to Magenta), and the B(Blue to Yellow) color channels independently 
by pressing command-1, command-2, and command -3, respectively. In 
switching to L (Lightness) channel, you are likely to eliminate
the moire pattern by working only in this channel.
    To fix the moire pattern (command-1), I applied both the Gaussian Blur and 
Median commands in fairly hefty doses. First I chose Filter > Blur > Gaussian 
Blur and specified a radius value of 1.5 pixels, rather high considering the 
image measures only about 300 pixels tall. Then I chose Filter > Noise >
Median and specified a radius of 2. (Unlike Gaussian Blur, Median doesn’t 
accept decimal values.) The result was a thickly modeled image with no 
moires but little detail.

Making the Most of Photoshop Filters by Deke McClelland

mailto:mjaylocation@yahoo.com
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Adjusting Image size in Photoshop  6, 7, CS, CS2, CS5 & CS5	 > = submenu
	 Photoshop enables the user to change the height / width, resolution and 
ultimately the file size of the document.  To do so, Open your document in Photoshop, Go 
to Image>Image Size.
Within this dialog box, have the constrain proportions check and Resample Image.
	 By changing the width, the height will be changed and if the height is changed 
the width will change.  The correct resolution is 72 pixels per inch, but if there is any 
retouching involved, 144 DPI should be used, retouched and reduced in resolution within 
this dialog box.
	 Notice that in Image Size, pixels dimensions is mentioned. This is important 
since pixel measurements for web design is consistent.

72 pixels = 1 inch	 The Dimensions of an average resolution of a 15 to 17 monitor 
is 760 x 420 pixels per inch.

mailto:mjaylocation@yahoo.com
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Designing Internet safe background gif

Using Adobe Photoshop is required 
to create a background gif.  Open the 
program, go to file menu, New (fig.1), set 
the width and height in pixels, the resolu-
tion to 72 pixels per inch, set mode to 
RGB color with the contents, White.   Set 
the width to 2000 pixels  and the height 
to 1 pixel, and hit the OK button.  This will 
produce a very small file for background 
.  The file will be a very long horizontal 
that is 1 pixel high (fig.2).  Go to the 
rectangular marquee tool, located in the 
Photoshop toolbox (fig.3), the uppermost  
left hand corner of the toolbox.  Double 
click on the tool, which will bring up the 
marquee option box.   Go to work style 
pop up menu, and select  fixed to size, 
change the width to 144, the height,1, 
resolution (fig.4).  Move the marquee tool 
with the mouse to the far left corner of the 
file (fig.2) and click the mouse button.  At 
this point, Go the Window menu, Show 
Swatch palette (fig.5).  In the Swatch pal-
ette, Go to the Submenu, Load Swatches 
(fig.6), and located the “WEB216 CLUT” 
file.  This palette is the non-dithering pal-
ette that is common standard between all 
graphic web browsers, in which colors ap-
pear the same in 256 colors as in millions 
of colors.  Pick a color, and it will appear 
as the foreground color in the Photoshop 
toolbox (fig.7).  Go to the Edit menu 
(fig.8), Fill and fill with the foreground 
color with Opacity, 100, Mode, Normal.

(fig.1)

(fig.2)

(fig.3)

(fig.4)

(fig.5)

(fig.7)
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Saving as a GIF or JPEG Format

File> Save for Web in Photoshop CS CS3 & CS5

Saving as a GIF Format (Graphic Interchange Format supports a maximum of 

256 colors and is used for flat color graphics), but only 216 colors are common 

between the platforms for web browsers). Go to Setting>web palette for Internet 

safe color for graphics. Different GIF settings are also available. The 2-Up and 

4-UP tabs allows different visuals of the different states of optimization.

To save as a JPEG file format follow the instructions as GIF In the JPEG dialog 

box, experiment with the JPEG settings to find the best result for each photograph. 

Set the options to maximize image quality while keeping the file size as small as 

possible.

JPEG (Joint Photographic Experts Group) has become the standard for displaying 

photographs and other continuous tone images on the web. The JPEG is a lossy 

compression  routine that reduces file sizes without reducing color depth (JPEG 

supports millions of colors). Because JPEG is a lossy technique, don’t resave a 

JPEG format again as a JPEG. The image will deteriorate.

mailto:mjaylocation@yahoo.com
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